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1. Introduction 

 

This document sets out the data requirements for the recalibration of the non-life 

underwriting risk (NLUR) module in the standard formula for the Solvency Capital 

Requirement under SAM. The data provided will be used to recalibrate factors for premium, 

reserve and natural catastrophe risk. In addition, data is collected to be used to review 

potential simplifications on 1st Party Cells. 

We have provided four files: 
1. FSB NLUR Data Request 2012 - User Manual.pdf (this document, explaining how to 

complete the data request) 
2. FSB NLUR Data Request 2012 - Main Workbook.xlsb (data to be provided in this 

workbook in a standard format) 
3. FSB NLUR Data Request 2012 - Underwriting Year Workbook.xlsb (relevant where 

data to be provided is by underwriting year) 
4. FSB NLUR Data Request 2012 - Qualitative Questionnaire.docx (to be submitted 

together with the workbook mentioned above) 
 
Before getting started 
It is required to enable the Solver add-in in the Excel Options dialog box for some of the 

macros in the workbook to work. 

1. Click the Office Button, and go to Excel Options. 

 

 

 

 

 

 

 

 

 

 

2. Click Add-Ins (on the left-hand side) 
3. In the Manage drop-down box, select Excel Add-ins, and then click Go... 
4. In the Add-Ins dialog box, select Solver Add-in, and then click OK. 
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After you have enabled the Solver add-in, Excel will auto-install the Add-in if it is not already 
installed, and the Solver command will be added to the Analysis group on the Data tab in the 
ribbon. 

The next step is to display the Developer tab if it is not already displayed: 

1. As before, click the Office Button, and go to Excel Options. 
2. Click Popular, and then select the Show Developer tab in the Ribbon check box. 

The final step is to establish a reference to the Solver add-in in Visual Basic: 

1. Select the Developer tab, and go to Visual Basic. 
2. Select References… under the Tools menu. 
3. Select the SOLVER check box, and click OK 
4. Close the Microsoft Visual Basic and Excel windows. 
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2. First Party Cell Captives / Programmes 

 

2.1 Simplifications review 
 

See worksheet [Inputs_ 1stPartyCaptives] 
 
The aim is to review potential simplifications on 1st party captives/programmes. The Inputs_ 

1stPartyCaptives tab is used to collect data for this review. 

2.2 Data requirements 
 
Notes to aid the completion of this tab:   

 T(0) represents the current year, T(-1) is current year minus 1 etc. 

 Table 1:  "Individual Loss Retention" - Individual retention in nominal terms (i.e. 

ground-up). If multiple limits exist, all limits to be included. 

 Table 1:  "Aggregate Loss Retention" - Annual(ised) aggregate limits. 

 Table 1:  "Underlying Deductibles" - Underlying deductibles as per policy. If mupltiple 

deducibles exist, all to be included. Specific mention if underlying deductibles change 

following exhaustion of aggregatye limits in a given underwriting period. 

 Table 4: "EML" - NatCat and ManCat EML's as per internal risk management 

estimates. 

 Table 5: "QIS 1 SA Uncorrelated Capital Requirements" - SAM QIS 1 SA Premium & 

Reserve Risk and Cat charges as per results submitted. 
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3. Natural Catastrophe Risk Calibration 

 

3.1 Catastrophe Risk Analyses 
 

See worksheets [Inputs_total sum insured (TSI)] and [Info_TSI_zone_mapping] 
 

Detailed South African exposure information is required as at 1/1/2012 or the latest financial 

year-end (whichever option is more convenient). This will be used to recalibrate the natural 

catastrophe risk parameters.  

3.2 Data requirements - Exposure 
 

 Total sum insured by postal code and sub-line of business 

Sub-lines 

Property (other than 
corporate) 

Buildings including 
Business Interruption 
and Loss of Rent 
 

Residential 

Commercial/Industrial (other than Corporate) 

Corporate 

Contents Residential 

Commercial/Industrial (other than Corporate) 

Corporate 

Engineering  Contractors All Risks 
Erection All Risks 
Plant All Risks 

Motor Own Damage  Private 

Commercial 
 

 Total Sum Insured should be captured in ZAR ‘000 

 Only exposure that will be exposed to a natural catastrophe risk should be 

captured, for example exclude any Liability cover 

 Official Postal codes from the Post office should be used as a guide 

o Worksheet [Info_TSI_zone_mapping] includes a table on how the postal 

codes are mapped to the zones that will be used in the calibration (as per 

QIS2) and  CRESTA zones 

 It is acknowledged that this level of detail is not always available and in these 

cases we would prefer accuracy over completeness. Exclude exposure without 

postal codes and in worksheet [Inputs_total sum insured (TSI)], indicate the 

percentage of allocated exposure, to the total exposure.  

 In some cases, it may be difficult to distinguish between Commercial/Industrial 
and Corporate business.  

 The following guideline has been provided to assist companies. This is only an 
indication and information should still be captured under Corporate if the 
participant’s definition is different. Corporate business may include: 

o Large risks (cut-off varies from client to client, ranges between R250m 
and R500m) 

o Risks that tend to have multiple locations 
o Mining risks  
o JSE listed entities 
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4. Premium & Reserve Risk Calibration 

 

4.1 Premium and Reserve Risk Analyses 
 

See worksheets [Summary], [Inputs_company information], [Inputs_claims triangles], 
[Inputs_premiums], [Checks_QIS2 TP_Total], [Checks_QIS2 TP_PCO by year], [Data 
valuation checks] and [Template] 

 
Various models and parameterisation techniques will be employed to quantify appropriate 
levels of premium risk and reserve risk by line of business. 
 
Two workbooks are provided; one where the data is required by accident year and the other 
where data is required by underwriting year. Primary insurance data will mostly be available 
by accident year. Some proportional reinsurance may also be available by accident year, 
usually when reinsurance is arranged within a group of companies. This data should be 
provided through the first workbook. Proportional reinsurance data by underwriting year, as 
well as any data relating to non-proportional reinsurance should be provided through the 
second workbook. 
 
To assess premium risk and reserve risk, we will consider the following by 
accident/underwriting year: 

 The historic levels of paid claims reported in the first year after policy inception. 

 The reserves posted after the first development year. 

 The earned premium (accident year) or written premium (underwriting year). The 
latter should usually be an estimate of the ultimate written premium for the most 
recent underwriting year. 

 How opening reserves compare against the amounts paid in the subsequent 
calendar year along with the associated closing reserves. This will be done 
individually per company. 

 The implementation of one year reserving risk approaches directly from the triangles 
of paid and/or incurred data. 

 
4.2  Data requirements 

 
4.2.1 Company information 

 
See worksheet [Inputs_company information] 
 
Various sections of information are requested: 

 Reporting, business and product information 

 Submission Information 

 Non-life lines of business in which business is written 
 
If any information is not adequately provided, error messages will be shown when clicking on 

the buttons on this tab. 

Most of the responses should be selected from drop-down lists (fields highlighted in a shade 

dark beige). Free fields are highlighted in light beige. 

The final section provides information about the lines of business written by the company. 

The first column should be used to indicate all the lines in which the company writes 

business, regardless of whether claims data is available in the required format. The second 
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column should be used to indicate the lines for which at least some claims data is available 

in the required format, even if this is not available for 100% of the portfolio. 

The segmentation is mostly similar to the segmentation for SAM QIS2. Please refer to 

section TP.1.14. of the QIS2 technical specifications for definitions of the various lines. 

There are two deviations in this data request from the QIS2 segmentation: 

1. Aviation is split from Marine and Transport. Any aviation related transport should be 

included under Aviation. 

2. Consumer credit is added as a separate line. 

It should be attempted to provide an accurate split by line of business; however, where this 

is not possible it is preferable to provide data than not to. Please provide an explanation 

through the attached questionnaire where you’ve deviated from requested segmentation. 

There are two buttons at the top of the screen in row 8: 

1. Data Validation 

2. Calibration 

These buttons should only be clicked after completing the following three tabs: 

1. Inputs_company information 

2. Inputs_claims triangles 

3. Inputs_premiums 

Other tabs may be completed before or after clicking those buttons. The buttons should be 

clicked in the order indicated above. It might be required to run the data validation multiple 

times, depending on the assessed quality of data provided. 

A message will appear in cell C6 to indicate the Data validation status. This could be one of 

the following: 

1. Data validation checks have to be run before continuing with the calibration – 

this will appear if the Run data validation button is yet to be clicked. It will also appear 

after making any changes to data captured in the three tabs listed above. 

2. The 'Inputs_company information' tab has to be completed before continuing 

with the calibration – this will appear after running the data validation, if any of the 

relevant fields have been left blank 

3. LoB indicators on the 'Inputs_company information' tab are inconsistent and 

has to be corrected before continuing with the calibration – this will appear after 

running the data validation, if for any of the lines of business it had been indicated 

that the company does not write business in that line, but that it has claims data 

available for that line 

4. The 'Data validation output' tab has to be completed before continuing with the 

calibration – this will appear after running the data validation, if there are any errors 

on the data validation output tab that haven’t been adequately responded to 

5. Errors indicated in column G of the 'Data validation output' tab has to be 

corrected before continuing with the calibration – this will appear after running 

the data validation, if any of the items on the data validation output tab have been 

flagged as errors to be corrected 
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6. Data validation OK – this will appear after running the data validation, indicating that 

the data validation has been satisfactorily completed. 

 
4.2.2 Claims data 

 
See worksheet [Inputs_claims triangles] 

 
Claims data is requested in the format of run-off triangles by accident/underwriting and 
development year. Triangles start from 21 years prior to the chosen valuation date but 
companies should provide data from the year for which they have reliable information. The 
level of detail requested in the sheet may not necessarily be available. Companies are 
requested to provide accurate data and focus on the quality of the data rather than the 
quantity of the data. It might for example be possible to provide accurate claims triangles for 
40% of the portfolio in one accident year and 70% of the portfolio in the next accident year. 
Where this is the case, information on those portions of the portfolio should be provided and 
the percentages shown next to premium data (refer to the next section). 
 
Companies should provide triangles that exclude natural catastrophe claims resulting from 
events with an estimated return period of longer than 10 years. Similarly, any claims relating 
to events allowed for under the man-made catastrophe section of the SAM standard formula, 
should be excluded from the experience. If this is not possible or if there is uncertainty 
around the definition of such events, it should rather not be excluded from the data. 
 
Six claims triangles are asked for per line of business: 

1. Gross (of reinsurance) cumulative paid claims, including claims handling expenses. 
Allow for amounts received in respect of recoveries and salvages. 

2. Gross cumulative reported claims, i.e. triangle 1 + reported outstanding claims 
reserve (OCR), including estimates for claims handling expenses (excluding IBNR). 
Do not allow for estimates of future salvages and recoveries. 

3. Gross projected ultimate claims, i.e. triangle 2 + projected future claims movements, 
including incurred but not reported claims (IBNR), incurred but not enough reported 
claims (IBNER) and estimates for claims handling expenses. This table should only 
be completed if reliable historic estimates are available that were based on actuarial 
projection methods. It’s not required for those estimates to match actual reserves 
held by a company. Thus it is also acceptable to calculate estimates now that would 
have been held at a point in the past, had an appropriate actuarial method been 
used. Any claims estimates shown should be undiscounted. The projected ultimate 
amount should be for the full origin year. 

 
Triangles 4-6 are similar to triangles 1-3, but net of reinsurance. All triangles should include 
ALAE (allocated loss adjustment expenses) but exclude ULAE (unallocated loss adjustment 
expenses). Some companies might have accurate gross claims data but not accurate net 
claims data; or vice versa. Similarly, some companies might have accurate paid claims data 
but not accurate reported claims data, or vice versa. In those cases companies may choose 
to complete selected triangles.  

 
4.2.3 Premium data 

 
See worksheet [Inputs_premiums] 

Premium data is requested by line of business and by origin year. Where the accident year 

definition is used, earned premium should be provided. Where the underwriting year 

definition is used, full written premium by underwriting year is requested. It might be 
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necessary to provide an estimate of the ultimate written premium for the most recent 

underwriting years. 

This is requested gross and net of reinsurance. Data captured in the first two columns 

should relate to the portion of the business for which claims data is provided. Data captured 

in the next two columns should be for the entire portfolio of the company. 

The next two columns contain hidden formulas that will show the percentage of business by 

premium volume for which claims data is provided. The cells aren’t locked, so you are able 

to capture values in those columns if needed for some reason. 

The last column asks for an initial expected loss ratio. This should be interpreted as the 

expected ultimate claims, including claims handling expenses, divided by the expected 

ultimate premiums, by year, as at the start of the year prior to any knowledge about actual 

experience for that year. This should only be provided if the information is available. 

Allocation of premiums to segments should be done consistently with the allocation of 

claims. It might be necessary to allocate premiums bases on estimated portions of overall 

premiums being collected in respect of different components of claims. This could for 

example be done based on historical claims splits. 

4.2.4 QIS2 check data 
 
See worksheets [Checks_QIS2 TP_Total] and [Checks_QIS2 TP_PCO by year] 

This information should just be provided by companies that are participating in QIS2, or 

companies that are not participating but have attempted the technical provisions calculations 

in line with the QIS2 technical specifications. 

Most of the information asked for in the worksheet Checks_QIS2 TP_Total have been asked 

for in the QIS2 workbooks. Information provided should be consistent with what had been 

submitted for QIS2. Please refer to section SCR.9.12. for definitions of the various 

components of the technical provisions. 

Information asked for in the second worksheet might be readily available for all years. 

Companies are asked to provide information for those years for which information is 

available.  

4.2.5 Company specific calibration 
 
See worksheets [Summary], [Template] and [Calibration_xxx_Gross/Net], where the latter 

worksheets will be hidden until the Populate calibration tabs macro has been successfully 

run. 

Significant improvements have been made to this data request compared with the first 

request to industry at the end of 2011. One of those is that companies will be able to see the 

results of the various premium and reserve risk calibration methods as applied to their data. 

As such we’re providing industry with a better understanding of the SAM NLUR calibration 

process. Companies are also able to compare the factors based on their own data against 

the factors based on industry data. This might give an indication of the extent to which it 
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might be beneficial to use an internal model or undertaking specific parameters instead of 

the unadjusted standard formula. 

Caution should be taken when interpreting these factors. For example, the factors might not 

be very credible for a company with little history. 

It further gives industry the opportunity to comment on the appropriateness of applying 

various calibration methods to their data. The methods are based on techniques used in 

deriving premium and reserve risk factors for Solvency II, as explained in the following two 

documents: 

1. CEIOPS’ Advice for Level 2 Implementing Measures on Solvency II: SCR Standard 

Formula Calibration of Non-life Underwriting Risk – 8 April 2010 (this can be 

downloaded from 

https://eiopa.europa.eu/fileadmin/tx_dam/files/consultations/consultationpapers/CP71

/CEIOPS-DOC-67-10_L2_Advice_Non_Life_Underwriting_Risk.pdf) 

2. Calibration of the Premium and Reserve Risk Factors in the Standard Formula of 

Solvency II: Report of the Joint Working Group on Non-Life and Health NSLT 

Calibration – 12 December 2011 (this can be downloaded from 

https://eiopa.europa.eu/fileadmin/tx_dam/files/Press-Room/releases/EIOPA-11-163-

A-Report_JWG_on_NL_and_Health_non-SLT_Calibration.pdf) 

The Template worksheet shows the formulas applied for the various methods. The 

determine the factors on a specific data set, one could copy populate the paid claims, 

reported incurred claims and premiums sections (highlighted in blue). Some of the methods 

require the Solver to be used. This is indicated next to the calibrated factors in each case. 

This document does not go into more detail on how to manually apply the calibration to a 

specific data set, since this process is automated in the workbooks by clicking on the 

Populate calibration tabs button. 

The process to follow: 

1. Complete the three tabs mentioned in section 4.2.1 

2. Click the Run data validation button on the Inputs_company information tab 

3. Correct any valid errors highlighted through this or provide explanations to apparent 

errors on the Data validation output tab. 

4. Re-run the data validation. 

5. If the Data validation status on the Inputs_company information tab is Data validation 

OK, click the Populate calibration tabs button on the Inputs_company information tab 

6. View the fitted parameters by line of business and calibration method on the 

Summary tab 

 

 

https://eiopa.europa.eu/fileadmin/tx_dam/files/consultations/consultationpapers/CP71/CEIOPS-DOC-67-10_L2_Advice_Non_Life_Underwriting_Risk.pdf
https://eiopa.europa.eu/fileadmin/tx_dam/files/consultations/consultationpapers/CP71/CEIOPS-DOC-67-10_L2_Advice_Non_Life_Underwriting_Risk.pdf
https://eiopa.europa.eu/fileadmin/tx_dam/files/Press-Room/releases/EIOPA-11-163-A-Report_JWG_on_NL_and_Health_non-SLT_Calibration.pdf
https://eiopa.europa.eu/fileadmin/tx_dam/files/Press-Room/releases/EIOPA-11-163-A-Report_JWG_on_NL_and_Health_non-SLT_Calibration.pdf
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5.  Qualitative Questionnaire 

  

Feedback provided through the qualitative questionnaire will provide context to the 

information received and enable more informed decisions to be taken when working through 

the calibration process. Kindly provide as much detailed and relevant information as 

possible, including comments about the appropriateness of the various calibration methods 

and suggestions for alternative methods. 

 

 

6. Queries 

 

In an attempt to provide a more robust template for the data collection, certain components 

of the workbook might be more complex to interpret than in the first data request in 2011. 

Any questions or comments regarding the data request should be sent to Grant Bushney 

(grant.bushney@fsb.co.za), the project manager for the SAM unit.  Grant will refer any 

technical queries onto the relevant individuals as required. 
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